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Chapter 11 Using the Source Editor

This chapter describes the basic functionality of the   
GoLive CyberStudio Source Editor, explains its interaction 
with the Palette, provides information on selected menu 
commands, and gives instructions on how to edit Web 
pages in source mode. You should be familiar with the 
contents of this chapter before starting to edit HTML code 
in source mode.

General The GoLive CyberStudio Source Editor is a convenient text-oriented 
Web page editor that makes your GoLive CyberStudio Web publishing 
package complete. 

The Source Editor adds more than basic HTML editing functionality to 
GoLive CyberStudio, allowing you to view your document’s HTML 
source code, check the HTML syntax, fine-tune your code, or even 
build Web pages from scratch. 

A typical Source Editor screen appears below.

The Source Editor Screen

The Source Editor comes with a set of powerful features that provides 
valuable assistance to the HTML-savvy user. Syntax highlighting, drag 
& drop, and other tools ensure that HTML source code editing is not 
the tedious process it used to be. 
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User Profiles The GoLive CyberStudio Source Editor has been designed with the 
seasoned HTML programmer in mind. 

If you are a seasoned HTML programmer with a good working 
knowledge of Hypertext Markup Language and have been using 
other text-oriented HTML editors, you will find the Source Editor very 
useful for tweaking and fine-tuning the underlying HTML code. 

After completing the layout of your Web page in Layout mode, you 
may want to use the Source Editor to check the structure of your 
HTML code and make minor corrections, if necessary. You can use 
the Source Editor to your advantage to add, for example, custom at-
tributes or edit string values. 

Basic Features The editing functionality of the Source Editor is similar to that of any 
other text editor for the Macintosh: 

• You can create a new document within the Source Editor by 
choosing the New command from the File menu. A blank win-
dow will be opened on the screen, allowing you to type or paste 
text from another document, application, or text clippings from 
the Finder. 

• After you have done some basic editing, you can save your new 
document using the Save command from the File menu. 

• You can also open an existing GoLive CyberStudio, HTML, or text 
document using the Open command from the File menu.

• Typing inserts characters at the insertion point, which is dis-
played as a blinking vertical bar. Selected text is replaced by the 
first typed character, and the insertion point is placed after the 
first typed character.

• Selected text in the frontmost (active) window is highlighted 
using the default highlight color selected in the Color control 
panel. 

• As you type, the Source Editor scrolls the window’s contents hori-
zontally or vertically so that the insertion point is visible. 
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Text Formatting The Source Editor allows you to apply the basic text formatting com-
mands from the Format and Style menus (see The Style and Format 
Menus on page 80 for reference) to selected text in the Body section 
of your page. 

The following screenshots show the text formatting commands avail-
able in the Format and Style menus.

Source Editor Commands 
in the Edit Menu

To format a paragraph in Source mode, proceed as follows:

1 Triple-click the paragraph to highlight it.

2 Go to the Format menu and choose the desired paragraph style.

To format selected text in Source mode, proceed as follows:

1 Double-click the text to highlight a single word, or click and drag 
to highlight more text.

2 Go to the Style menu and choose the desired character style. 
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Syntax Highlighting Syntax highlighting works in the background, continuously mon-
itoring user input and comparing it with the content of the tag 
database. 

When the syntax highlighting feature recognizes a tag, it highlights 
the start and end tags and tag attributes to indicate that the syntax 
is complete. 

Syntax Highlighting 
in the Source View     

Syntax highlighting uses eight different colors to visually separate 
tags, attributes and document content, thus making it easy for au-
thors to keep track of their HTML code. An example of highlighted 
HTML code is shown above.

The default color for HTML tags is blue.

The default color for tag attributes is brown.

The default color for visible content is black.
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Syntax Checking Syntax checking ensures that your Web pages contain only valid and 
error-free code. The built-in syntax checker parses your HTML code 
against the coding rules stored in the tag database and highlights 
code elements presumed faulty. 

Syntax Checking in the Source View

To launch the syntax checker, proceed as follows:

1 Choose the Check Syntax command from the Special menu.

2 The syntax checker should highlight the first code element pre-
sumed faulty now.

3 Check the status line at the lower left corner of the window to 
learn more about the error.

4 Correct the error.

5 Choose the Next Error command from the Special menu or press 
Command-Option-“+” (the plus sign on the numeric keypad) to 
continue to the next error.

To return to the last error, choose the Previous Error command 
from the Special menu or press Command-Option-“-” (the minus 
sign on the numeric keypad). 

Syntax Checking Commands 
in the Special Menu 

The syntax checker has found a faulty end tag.

The status line identifies the fault.

Choose Check Syntax to launch the syntax checker.

Choose Next Error to continue.

Choose Previous Error to go backward.
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Drag & Drop Support Drag & drop insertion is available for Body and Forms tags from the 
Palette as well as text clippings from the Finder or any other software 
that supports Macintosh drag & drop. 

The following screenshot illustrates the drag & drop insertion of a 
line tag from the Palette.

Drag & Drop Insertion of a Line Tag

The Source Editor lets you drop Palette items in the flow of your HTML 
code and use them as editable tag templates. 

After inserting a tag, you can edit its attributes and attribute values 
while the Source Editor monitors your input and highlights typing er-
rors or incomplete syntax.

Drag & drop coloring is also supported. You can drag a color from the 
preview pane of the Color Picker (see Coloring Text and Objects on 
page 301) and drop it on your HTML code. 

Further drag & drop options include pages and URLs from the Project 
window. Dropping a page or URL icon creates a link instantly, refer-
encing the page or URL you have dropped.

While you are dragging, the cursor moves along 
the margin to indicate the current insertion 
point.
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Automating 
Operations Using 
AppleScript

The GoLive CyberStudio Source Editor can be controlled using 
AppleScript, the powerful scripting language developed by Apple 
Computer to automate repetitive tasks on the Macintosh. Scripting 
enables experienced users to add a complete suite of specialized 
HTML formatting commands to the basic editing functionality of the 
Source Editor and to build pages automatically. 

GoLive CyberStudio’s 
AppleScript Dictionary 

The following sections outline how GoLive CyberStudio’s Source Edi-
tor works with AppleScript to automate tasks. 

To use AppleScript, you need the AppleScript extension in-
stalled in your Extensions folder as well as the Script Editor.

You also need a working knowledge of AppleScript to use the 
following script command reference to your advantage. For in-
structions on how to use AppleScript, please refer to the appro-
priate documentation available from Apple Computer.

Containers If the user doesn’t specify any container, the script addresses the doc-
ument with the active window. If this document is not in HTML 
mode, the script automatically switches to HTML mode. Scripts can 
also address a particular window or document directly, using either 
its position on screen or its name. 

Click here to view an AppleScript command.
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Lines, Characters, and 
Selections 

The Source Editor window contains Objects of the Line and Character 
types. These objects represent physical lines or characters, which can 
be addressed as single entities or in groups. You can use the usual 
AppleScript syntax to address lines and characters:

Line 1
Character 1234 
the last Line 
Characters 10 thru 20 of Line 11.

The Character object exists either at the document or line level. At 
the document level, it refers to a single character within the docu-
ment, starting at position 1. At the line level, it refers to a single char-
acter on the specified line, starting at position 1. Both the line and 
column or character specifications start at position 1.

The Selection object reflects the current selection. The selection is in-
valid if nothing is selected. This sets the Is Visible property of the se-
lection to false. 

A selection can be created in many ways—for example, by manipu-
lating the Starting Point or Ending Point properties of the Selection 
object or by using the Select command. The Select command requires 
a line or character object or a from/to specification such as “from 
{line,column} to {line, column}”. All Paste operations select the 
pasted text by default.

The current selection can be deleted using the Delete Selection or De-
lete commands, while the Deselect command cancels the current se-
lection.

All objects have Property Contents to allow direct access to their con-
tent. The Length property indicates the number of characters con-
tained in the object. 

Line and Character objects have additional common properties. The 
Index property indicates the number of an object, the number of a 
line, or the position of a character within a document. 
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Cursor Positioning The Position property is also common to both objects. This property 
contains a list made up of two elements and uses a {line, column} 
syntax. There are several ways to specify the cursor position within 
the editor window. You can use the Go to command to place the cur-
sor in a line or on a character. Go to expects a Line or Character object 
as its function argument:

Go to Character 1 of Line 15 
Go to Line 10 
Go to the last Character

A more direct approach to positioning uses the Line Index and Col-
umn Index properties. These properties contain the current line and 
column, and they can be read out and set:

set This Line to 123 

Core Elements Objects 

Window 

The Window object supplies information on a window. It s comprised 
of the pertinent document objects.

Bounds Rectangle R/W Window size and position. 

Has Closebox Bool R/O True if the window has a close box. 

Has Titlebar Bool R/O True if the window has a title bar. 

Hide on Deactivate Bool R/O True if the window disappears upon 
deactivation. 

Is Floating Bool R/O True if the window is a floating window. 

Is Resizable Bool R/O True if the window has a growbox. 

Is Zoomable Bool R/O True if the window has a zoombox. 

Index Long R/O Index of windows in the window list 
(starts at 0). 

Title Text R/O The window name. 

Visible Bool R/O True if the window is visible. 
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Methods

General Text 
Handling Elements

Document 

The document object is comprised of the entire document. It con-
tains general properties, such as the current selection.

Close Object Closes the specified object (window or 
document).

Open Object Opens the specified object.

Save document Saves a document. 

[File filename] The name of the file to be saved.

New Document Opens a new document.

Activate Window window Activates a window.

Clipboard Text R/W This property allows for accessing the 
clipboard. It can be used as a function 
argument for the Insert Text method. 

Contents Text R/W The content of the document. 

Length Long R/O The length of the text in the document. 

Font Name Text R/W The name of the font used. 

Font Size Short R/W The size of the font used. 

Font Face Enums R/W The attributes of the current font. The list 
includes the Bold, Italic, Underline, 
Outline, Shadow, Condense and Extend 
elements. You can omit the braces if you 
wish to specify a single attribute only.

Tab Stops Short R/W The tab stop position. 

MIME Type Text R/O The MIME type of the document. This 
function returns “text/html” by default. 

Syntax Highlighting Bool R/W Toggles Syntax Highlighting on and off. 

Auto Indenting Bool R/W Toggles Auto Indenting on and off. 

Line Index Long R/W The number of the current line. 

Column Index Long R/W The current column. 

Current Line Object R/O The current line as a line object. 

Selection Object R/O The current selection. 

Status Line Text R/W The content of the status line. 
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Line 

The line object refers to a specific line.

Character 

The Character object refers to a specific character.

Selection Object 

The Selection object exists all the time, even if there is no current se-
lection. The Is Visible property indicates whether the selection exists 
or not. The selection can be modified by changing the Starting Posi-
tion and Ending Position properties. Changing the Contents property 
replaces the current selection with the specified text.

The Selection object can be addressed through the Selection property, 
not by its name.

Index Long R/O The line number, starting at 1. 

Position list R/O The Position as a list with the {line, 1} 
syntax. 

Contents Text R/W The content of the line. 

Length Long R/O The length of the text on the line. 

Index Long R/O The position of the character, relative to the 
beginning of the document at position 1. 

Position list R/O The position as a list with the {line, 
column} syntax. 

Contents Text R/W The content of the character. 

Length Long R/O The length of the character (constant 1). 

Starting Position list R/W The beginning of the selection.

Ending Position Long R/W The end of the selection.

Is Visible Bool R/O True if a selection exists.

Contents Text R/W The content of the selection. 

Length Long R/O The length of the text in the selection.
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Methods

Insert Text “Text” Inserts the function parameter as text 
at the current position.

Insert File filename Inserts the specified file at the current 
cursor position.

Find “String” Searches for the specified string. The 
result is true if the string has been 
found. The found string will be 
selected. 

[Applying Option(s)] Applies the specified options. One or 
more options may be specified. 
Multiple options must be specified as 
a list in braces.

Available Options:

Ignore case Distinguishes between uppercase and 
lowercase.

Wraparound Wrap around the beginning or the 
end of the document.

From Top Start the search at the beginning or 
the end of the text or the current 
selection.

Backwards Search direction is backwards.

Word Search word by word.

Replace “String” Searches for the specified string and 
replaces it with another string. The 
result is true if the string has been 
found and replaced. The found and 
replaced string will be selected. If the 
direct parameter is omitted, the 
current selection is replaced with the 
specified string. 

Using “String” The string used for replacing.

[Applying Option(s)] Applies the specified options. One or 
more options may be specified. 
Multiple options must be specified as 
a list in braces.

Available Options:

Ignore case Distinguishes between uppercase and 
lowercase.

Wraparound Wrap around the beginning or the 
end of the document.

From Top Start the search at the beggining or 
the end of the text or the current 
selection.

Backwards Search direction is backwards.

Word Search word by word.
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Undo Undoes the last changes.

Redo Restores data to the state before the 
last Undo action.

Delete Object Deletes the specified object, which 
may be the selection object, a line, or 
other. If the object is not specified, it 
deletes the current selection.

Select Object Makes a selection. The specified 
object may be a suite of lines or 
characters—for example, “Lines 3 
thru 7”.

From List Alternatively, the selection may be 
specified using two lists with a {line, 
column} syntax for the beginning 
and end of the selection.

To List

Select 
paragraph

This command searches a blank line 
before and after the current line and 
selects the text between the two blank 
lines and the subsequent blank line, 
positioning the cursor on the blank 
line. In the example given below, the 
cursor is placed on the line “1st Line”. 
The asterisks mark the lines that will 
be selected after executing this 
command.
  1st line
* 2nd line
* 3rd line
* 4th line
  etc.

[Between Object] Optionally, the selection can be 
confined to particular lines by 
specifying a range explicitly. 
Example: “Select Paragraph Between 
Lines 3 thru 5”.

Deselect Cancels the current selection.

Go to Object Sets the current position to the 
specified line or character object.

Delete spaces Deletes all spaces and tabs from the 
current position to the end of the line 
or to the next character that is 
neither a space nor a tab.
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HTML Extensions Methods

The following methods wrap the current selection in a start tag and 
end tag of a specified type. Multiple tag types can be specified using 
a list. The following types are supported:

Style Tag Type 

Address <ADDRESS>selection </ADDRESS> 

Blink <BLINK>selection </BLINK> 

Blockquote <BLOCKQUOTE>selection </BLOCKQUOTE>

Bold <B>selection </B>

Citation <CITE>selection </CITE>

Code <CODE>selection </CODE>

Definition <DFN>selection </DFN>

Emphasis <EMP>selection </EMP>

Italic <I>selection </I>

Keyboard <KBD>selection </KBD>

Listing <LISTING>selection </LISTING>

Preformatted <PRE>selection </PRE>

Sample <SAMP>selection </SAMP>

Strikethrough <S>selection </S>

Strong <STRONG>selection </STRONG>

Subscript <SUB>selection </SUB>

Superscript <SUP>selection </SUP>

Teletype <TT>selection </TT>

Underline <U>selection </U> 

Variable <VAR>selection </VAR>
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Style Tag “String” The general form of the Style method 
uses the specified text as a tag. You 
can also specify attributes: 
Style Tag “A HREF=#Marker” 
<A HREF=#Marker>selection </A>

Heading Size Formats the current selection as a 
header. Size may range between 
1 and 6.

[with 
Alignment]
Left
Right
Center

Alignment options:
Left
Right
Center

Paragraph [Align] Inserts a P tag at the current cursor 
position.

Left
Right
Center

Alignment options:
Left
Right
Center

Base Font Size Inserts a BASEFONT tag at the current 
cursor position. Size may range 
between 1 and 7.

Font [“Name”] Wraps the current selection in a FONT 
tag. The name attribute is the font 
name.

[Size Word] Font size. This size ranges between 1 
and 7. 

[with Smaller] Reduces visible font size by using a 
negative relative size. Assumes -1 if 
not specified. 

[with Larger] Reduces visible font size by using a 
positive relative size. Assumes +1 if 
not specified.

List Art Formats the current selection as a 
list. The following list styles are 
available

Ordered numbered list (OL) 
Unordered simple list (UL) 
Definition definition list (DL/DD)
Term definition list (DL/DT)
Directory
Menu

[Type type] The type of bullet can be specified for 
simple and numbered lists:

Simple lists:
Disc solid bullet
Circle hollow bullet
Square solid square
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Numbered lists:
Arabic
Upper roman 
Lower roman 
Upper alpha
Lower alpha

Table [“Title”] Formats the current selection as a table, 
converting an optional title into a 
CAPTION tag. Each selected row is 
converted to one or mote table cells.

[Separator “characters”] Each row consists of one or more cells 
separated by the specified character. 
Common separators include the comma 
or tab character. If the number of 
columns has not been specified explicitly, 
the script determines the maximum 
number of entries in any one line of text 
within the highlighted section. Example: 
The following lines create a table with 
three cells per row when specifying “,” as 
a separator:
One
Two,three
Four,five,six
Seven,eight

[Rows Word] Row count. If the specified row count 
exceeds the maximum number of cells 
that can be generated out of the text, the 
script generates blank cells.

[Columns Word] Column count. If the specified column 
count exceeds the maximum number of 
cells that can be generated out of the text, 
the script generates blank cells. 
Specifying the number of columns 
prohibits the script from determining 
table width, provided a separator 
character has been defined.

[Border Word] Specifies the width of the border of the 
table.

[Cell spacing Word] Specifies inter-cell spacing.

[Cell padding Word] Specifies the cell padding.

[Width Text] Specifies table width. Table width must 
be entered as text in order to allow for 
values such as “50%“.

[with Heading] Specifying this parameter formats the 
first row of the table as a table header. 

Link “URL” Defines the current selection as a 
hyperlink, using the parameter as the 
destination URL.

Document 
layout

[“Title”] Converts the current document to HTML, 
inserting HTML, HEAD, and BODY tags 
and entering an optional title in a TITLE 
tag within the HEAD section. The BODY 
tag can be modified using a variety of 
options:

[Background “URL”] Specifies the background image.
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[Background 
color

“color”] Specifies the background color of the 
page.

[Text color “Color”] Specifies text color.

[Link color “Color”] Specifies link color.

[Visited link 
color

“Color”] Specifies the color of links already 
viewed.

[Active link 
color

“Color”] Specifies the color of the active link.

[Heading “Text”] Inserts the specified text as a header into 
the Body section using a H1 tag.

[Load script “Text”] Uses the text as a script for the ONLOAD 
attribute. After the script has been run, 
the previous first line of the document is 
the current line.

Check Syntax Verifies the syntax of the HTML 
document, returning the number of any 
error found.

Get Syntax 
Error

Index Get syntax error uses an index between 1 
and the number of the error found. The 
faulty code element is highlighted and 
the error description is displayed in the 
status line. The following error codes may 
be returned:

0 - Invalid error index

1 - Tag expected but not found

2 - Unknown Tag

3 - Found end tag without start tag

4 - No end tag found for specified tag

5 - Tag end character “>” expected but 
not found

6 - Found attributes in an end tag

7 - Specified tag has no end tag

8 - Unknown attribute

9 - Required attribute not found

10 - Attribute value not found

11 - Attribute does not support values

12 - Value specified without attribute

13 - Illegal value

14 - Illegal color code

15 - Value is not a number

16 - Unknown HTML special character

17 - Use “&amp;” instead of “&”

18 - End of file
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Source Editor 
Preferences

The General, Colors, and Font tabs in the Source group of the Prefer-
ences dialog box let you customize various basic settings that influ-
ence the behavior and appearance of the Source Editor. 

To open the Source group of the Preferences dialog box, proceed as 
follows:

1 Go to the Edit menu and choose Preferences.

2 Locate and click the Source icon on the scrolling sidebar. 

3 Click the tab with the desired options.

General Settings The General tab contains the following options: 

Selecting Code Preferences

The Tab Size text box sets the width of the indentation (in characters) 
added to lower-level tags.

The Enable dragging of  marked text checkbox toggles the internal 
drag & drop support on and off.

The Auto-indenting checkbox toggles the automatic indenting of 
lower level tags on and off.

The Relaxed checking of  special chars relaxes the rules applied to spe-
cial characters when checking the syntax. Enabling this option allows 
you to use uppercase-only characters as found in older HTML files 
and instructs the syntax checker to stop looking for a trailing semico-
lon. Example: The &lttag&GT string will be interpreted as &lt;tag&gt;.

Use this checkbox to toggle drag & drop 
on and off.

Use this checkbox to toggle the boldface screen 
font for HTML tags on and off.

Use this checkbox to toggle the relaxed checking 
of special characters on and off.

Enter the indentation (in character widths) for 
lower-level tags.
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Syntax Highlighting 
Preferences

The Colors tab contains the following options: 

Customizing Syntax Highlighting 

The color section allows for viewing the default colors used for syntax 
highlighting.

The Syntax Highlighting checkbox toggles syntax highlighting on and off.

The Bold Typeface for Tags checkbox selects a bold typeface for tags 
to make them stand out more clearly from the rest of the code. 

Font Preferences The Fonts tab contains the following options: 

Selecting a Custom Font 

You can select a custom font, font size, and font style for your HTML 
code to override the default Monaco 9pt plain setting.

Use this checkbox to turn syntax highlighting 
on and off.

Use this checkbox to toggle the boldface screen 
font for HTML tags on and off.

Use these options to select a custom font 
and style for plain text displayed in the edi-
tor window.

Preview your font preferences here.
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